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This manual details the use of Adcon’s addTIMER extension, a new
extension that is available with the addVANTAGE Pro software product,
which is used in conjunction with most of Adcon'’s telemetry devices.

For information about the installation and use of the telemetry devices,
refer to the respective device’s manual. Also refer to the addVANTAGE
Pro 5.x User Guide for complete information about the software
addTIMER runs under.

Adcon recently introduced the A724 addSWITCH, a controller for two
latching solenoids that can be integrated seamlessly into every Adcon
radio network. It soon became apparent that a software component for
addVANTAGE Professional 5.x that would allow the time-based
operation of valves was urgently needed. This first release of the
addTIMER extension meets this need.

Until now, valves could only be opened and closed by defining certain
IF - THEN rules, leading to an action as soon as a condition was
triggered. However, with the addTIMER extension, you can create an
irrigation program that will turn irrigation valves on and off at set times
each day.
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But the addTIMER is certainly not limited to operating irrigation valves.
You can also use it to turn pumps, motors, lights, and other devices on
or off, if time is the only decisive parameter for their operation.

Some examples for using the addTIMER extension follow.

You can automate the application of your irrigation water via an
irrigation schedule that best meets the needs of your crop and soil type.
For example, in heavy soils you might give one deep water each week,
while in sandy soils you might give the plants a short irrigation each day.

Many utilities offer lower rates for their electricity at night and on
weekends. You can use addTIMER to start your pumps automatically at
midnight (or whenever the rates get cheaper) and turn them off again
once your reservoir or storage dam is filled. You can use a level sensor in
the tank to signal when it is full. Similarly, you could use a low-level
threshold to start the pump during daylight hours.

At a certain time of day the lights in a park can be switched ON or OFF.
While this is usually controlled by a light sensor, you can imagine many
circumstances where light sensors might not be the best option (for
example, for insurance reasons, where a light is simply required to be
ON at a certain time of day).

In this first release, the addTIMER extension is limited to control based
on start and run times. In future releases, additional conditions will be
available, such as turning off the lights automatically when the level of
sunlight reaches a threshold. Another example could involver stopping
an irrigation cycle on the basis of soil moisture or rainfall, or if a pressure
sensor signals low pressure in the irrigation mainline (indicating a leak or
pipe burst).

This section describes the available platforms for the software and what
your system needs to run the software.
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The addTIMER software is available only with addVANTAGE Pro,
version 5.3 or higher, running on a Java 1.6 (or higher) platform. It was
tested on Microsoft Windows 2000 and XP.

The client runs in a web browser. Microsoft Internet Explorer 6.0 and
Mozilla Firefox 2.0 are currently supported.

We recommend using a dual-core processor with at least 2GHz and
1GB of RAM, with sufficient hard disk space to allow for larger
databases and backups (a backup required three times as much space
as the “normal” version). For example, for one year with 100 RTUs, you
would need approximately 4GB of disk space and another 16GB (4 +
3*4) = 16) for backups.

Note: The hardware configurations above are truly for minimum
systems. Don’t expect to run a server with tens of clients and tens
or hundreds of RTUs on such machines, which are more suited to
a single-user system. In addition, it is assumed that no other
applications are running except addVANTAGE Pro and the
operating system software.

You can download data either from another addVANTAGE Pro server or
directly from an Adcon Telemetry Gateway. If you have an A840 or A850
Gateway, you also need Sun Microsystem’s latest Java Virtual Machine,
as indicated for the addVANTAGE Pro server.

For more details about the Gateway's configuration, refer to the User
Guides of the A840 and A850 Telemetry Gateway and the A440
Wireless Modem. If you are running an A840 Telemetry Gateway, you
need to verify that you have the latest firmware installed. For your
convenience, we have included a version of this firmware on the
distribution CD. For more details about the Gateway's configuration,
refer to the Base Station—Telemetry Gateway A840 and Wireless
Modem A440 User Guide.

Note: addVANTAGE Pro is compatible only with the A840 Telemetry
Gateway running the firmware release 3.8.0 or higher. However,
addTIMER requires release 3.8.6 or higher to correctly support
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the switching functions.You cannot use an A730SD receiver to
retrieve data into addVANTAGE Pro 5.x.

This section explains standard terminology and usage for Adcon
software and manuals.

Although you may not see a software window that looks exactly like the
one shown in Figure 1, we have included it to illustrate the various items
on a software window.

Most operations in addVANTAGE can be performed on a context-
sensitive basis. That is, right-clicking an object displays a context-
sensitive menu from which you select the desired operation.

This manual does not attempt to explain basic computer use. Therefore,
you should be familiar with basic computer terminology and the use of
typical computer interfaces such as the mouse and keyboard.
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Figure 1. A Typical Software Window
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Text Field
Checkbox
Radio button
Listbox

Dropdown List

Button

Tab

Type information here.

Select or deselect by clicking the box. A selected
box has an X or a check mark in it, while a
deselected box is empty.

These round buttons come in multiples. You can
select only one.

This area shows a list of choices you can select by
clicking.

A box with a small down arrow ( ¥ ) you must click
before you can see the list of choices to select from.
These are rectangular shapes with a name. Select a
button by clicking it.

Click to see another view of the window.

Certain conventions apply in this documentation.

[talics

Bold

fixed font

File » Save

Note

CAUTION

WARNING

Indicate the text is variable and must be
substituted for something specific, as indicated in
the explanation. Italics can also be used to
emphasize words as words or letters as letters, and
for cross references to other books.

Indicates special emphasis of the text. Also
indicates menu names and items in a window.

Indicates characters you must type or system
messages, as well as default values and file names.

Indicates menu selection. For example, select the
File menu, then the Save option.

Indicates information of interest. Notes appear
after the information they apply to.

Indicates that you may get unexpected results if
you don't follow the instructions.

Indicates danger to yourself or damage to the
device if you don't follow the instructions.

You'll see the term tag used throughout this manual. Tag is a generic
term for something that pertains to data, regardless of whether it
collects or controls that data. Tags can represent any of the following:
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Physical sensors, such as those for temperature, leaf wetness, or
humidity.
Actuators, such as switches, relays, or valves.

Virtual sensors, which are the result of a computation, such as an
average, a sum, or an Etg (evapo-transpiration reading). Virtual
sensors are created with extensions. With some extensions, you
can use a virtual sensor in combination with other sensors to create
a new virtual sensor, which is itself another tag.



As with previous versions, the addVANTAGE Pro 5.x software can be
extended in functionality through additional software modules called
extensions. Extensions can be added at any time to an addVANTAGE
Pro system. The following two general purpose extensions are included
in the basic package and installed automatically while installing the
server:

o Main
° Statistic

Other extensions can be installed separately. For example, Adcon
Telemetry provides a collection of Plant protection and Irrigation
extensions in a package you can receive free of charge upon request
from your Adcon distributor. These extensions are documented in a
separate addVANTAGE Pro 5.x, Plant Protection and Irrigation
Extensions manual. This manual is located on the software CD, which
also contains these free extensions, or you can download it from Adcon
Telemetry's website at http://www.adcon.at.

But the addTIMER extension is what we are concerned with here. You
use the addTIMER extension to control valves connected to a number
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of different RTUs for an irrigation program. Adcon recommends that
you create a new area to house all of the RTUs used in irrigation control.

An irrigation program comprises a number of Shifts operating one after
the other. Each shift contains one or more valves, which will open for the
duration of the shift.

When the time comes for a program to start, addTIMER triggers the first
shift. At the end of the run time for the first shift, all the valves in the
shift will close again. The next shift then starts, and the process
continues until all shifts have run. If a program is set to run more than
once per day, the extension will wait for a time defined in the program
and then run again.

Future versions will add the ability to end a shift (and hence start the
next one) or stop the program altogether if certain alarm conditions
occur.

This chapter deals with the basic operations required for setting up,
configuring, and using the addTIMER extension.

Irrigation controllers function using a number of common principles, as
illustrated in Figure 2.

A controller executes an irrigation program. Some controllers support
only a single program but more complex units such as addTIMER let
you create and store multiple programs.

A program can be told to run immediately, or at different time
intervals—for example every day, every second day.
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Active Program
Program 2 o Shift 1
Shift 2
Shift 3 | Valve 13
Shift 4 Valve 14
Pgrirgrzrj - Shift 5 Valve 15
Yalve 21
Valve 22

Figure 2. Structure of an Irrigation Control Program

The number of times a program runs each day can vary from once to
continuously. If a program runs more than once, you can enter a delay
before each repeat of the program.

A program consists of one or more shifts. The shifts run sequentially,
meaning that as one finishes the next starts. Each shift will run for a
nominated time period.

Each irrigation shift will control one or more valves: for the duration of
the shift, all valves included in the shift will be opened (turned on).

Extensions can be added only to an area. If you have not already added
an area to house the extension, add one now by following these steps:

1.
2.

If the addVANTAGE Pro 5 server is not running, start it now.

Once the Server has started, log in with your allocated user name
and password.

After logging in, you are presented with a hierarchical view of the
areas and RTUs you have been given access to. Expand the tree by
clicking the “+" sign to the left of an entry or node.

When you have reached the level where you want to add the
addTIMER Extension, right-click the node and select New
Node » Area.

If the RTUs which you will be controlling have not been added to
the system, you can add them to this area now as well.
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To add the addTIMER extension to this area, do the following:

1. Select the area where you want the extension added.

2. Right-click the highlighted area and select New Node »
Extension » addTIMER.

Note: Only one extension of each type is allowed per area.

You use the tabs on the Properties dialog to configure the addTIMER
extension’s properties. To display an extension’s properties (Figure 3),

highlight it and select Edit » Properties..., or right-click the extension
and select Properties.

© http:/ilion.dmz.adcon.at: BOBO - Properties - Mozilla Fir... @@@

General | Extension | Inputs | Security |

QaddTimer

Location: jdeveloper's test machine/RTU 15/

Type: EXTENSION

Kind: ADDTIMER

Template: none

1D: 16

Error: 17/0

Warning: 0/0

Extension(s) Status:

® Enabled

O pisabled

oKk | Cancel | appy |

Done 1

Figure 3. Extension Properties window, General tab

Figure 3 shows the general properties specific to the addTIMER
extension. Note that the General, Extension, Security, and Inputs tab
properties are found in all extensions.
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The General tab displays general information about the extension and
allows you to enable or disable the extension by clicking the
appropriate radio button. Clicking the Attributes button displays a
dialog you can use to view the node’s attributes.

Figure 4 shows the tab you use to configure the addTIMER extension,
the Extension tab.

3 hitp:/ilion,dmz.adcon.at: BOBO - Properties - Mozilla Firefox

General | Extension | Inputs | Security [

Programs:

Name | Enahled] Status | | I Factor I Add

Direct Digital Output 3] WAITING START STOP 1.10 =
e Timar B waming 100 |EECEES
warTING Remove
Demo Valve ] WAITING 1.00

Fefresh

Description
The program is waiting for the next execution tme.

Ok | _Cancel | Agply |

Figure 4. Extension Properties window, Extension tab

The Programs table shows the existing programs. You can:

Enable or disable a program by selecting or clearing the checkbox
in the appropriate Enabled column.

View details of a program by selecting it in the table. The
Description box at the bottom of the dialog shows which shifts are
actually running and when the next shift will be started. The details
are automatically updated in frequent intervals.

View the status of a program (also automatically updated).

Manually Start or Stop a program by clicking the appropriate
button.

Add, edit, or delete a program as discussed later in this chapter.
Refresh the Programs table.
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The Inputs tab (Figure 5) allows you to set the input tags (valves) for the
extension. You can select tags wherever you want, as shown later in the

tag chooser.

D http:#lion.dmz.adcon.at: BOBO - Properties - Mozilla Fire... Q@i@

General | Extension | Inputs | Security |
—Valves
Id | Enabled | Status | | + I
13 CLOSED OPEN [#5]
14 CLOSED OPEN
OK | Cencel | Apply |
Done

Figure 5. Extension Properties window, Inputs tab

You can add (delete) valves to this extension, see their status, and open
or close a valve manually. If a valve is operated manually, the actions
taken by addTIMER are ignored (manual actions have higher priority

than automatic).

The Security Tab

Use the Security tab (Figure 6) to set the appropriate privileges on the
extension for different users and groups.
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) http:#lion.dmz.adcon.at: BOBO - Properties - Mozilla Fire...

General | Extension | Inputs | Security

—0Ownership
owner: addtimer b
Group: admin .
—Privileges
Owner: | Riead & Write b
Group: Fead & Whrite o
Everyone: | Fiead Only v
~—Publicity
Public available O

Apply to all enclosed nodes

ok | cancel | Apply |

Dane

Figure 6. Extension Properties window, Security tab

The first step in setting up the extension is to choose the outputs (which
are mapped to tags on an A723, A724, A732, A733 or A740) that will be
used to control irrigation valves. The A724 has been custom designed
to control two DC latching solenoids or DC latching relays. If you want
to control an AC Solenoid or switch an AC or DC load using one of the
other RTUs, you will need to add an external interface that adapts the
3.3V output from the RTU to the level needed to switch a solid state or
mechanical relay.

After doing this, you can create an irrigation program consisting of a
number of shifts. After creating the shifts, add the outputs or valves to
each. All outputs in a shift turn on at the same time and for the same
duration. If your irrigation system has a Main Valve (an output that, for
example, turns on the pump or opens a primary valve when any valves
or stations are on), you will need to add the Main valve to each shift.
Later versions of addTIMER will allow you to automatically allocate an
output as the Main Valve.
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This part of the setup procedure requires you to use some forethought
and planning.

A map of your irrigation system provides a handy reference point for
this step. The RTUs used to control irrigation will by necessity be
installed adjacent to the valves they control. When you add these RTUs
to the A840 or A850 Telemetry gateway and hence to addVANTAGE
Pro 5.x, you should name them with the name of the irrigation block or
valve, for example, Block 5.

When you add an RTU, the outputs are given a default name based on
the information recorded for that type of RTU in the Gateway. Later,
when you add the RTU to addVANTAGE Pro 5, the output is given the
same name. So, after adding the RTU to addVANTAGE Pro 5.x, select
the RTU and change the name of the output tag to something
descriptive. For example, for an RTU that will control irrigation via Valve
5, you could use “Change Digital (direct, logic 0=0V)" to “V5."” The tag
will then be visible with this shorthand as a meaningful name in the
addTIMER extension.

From the Explorer view in addVANTAGE Pro 5.x, right-click the
addTIMER extension and select Properties. When the Properties dialog
displays, click the Inputs tab.

If you have not added any Output tags, the list of Valves will be empty.
Note that in this context, digital tags are the same as valves.

Follow these steps to add tags to the Inputs tab:

1. Click the Add button to display the Tag Chooser shown in
Figure 7.
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2.

% http:/lion.dmz.adcon.at: BOBD - Tag Chooser - Mozilla Firefox [:__]EIEI

= |_g Adcon Weather Test RTU (79) ~ [ pummy Digital Status 104 (93)
= _g 26138 GPRS Muckendorf (201)
['4 26138 GPRS Muckendorf (202)
(8@l Main (299)
¥ :‘Id mmmm (272)

8¢ ) Adcon Weather Test RTU (80)
% Apple Scab (274)

Main (195)
Statistic (365)
+ |_g Distributor's Meeting (381)
g, Irrigation field 204 (37)
""" + ] 27889 WXT510 slat 15 min test (166)
# ] Ad4D STD (138)
+ ] A440 via A720Box (146)
+ _6 A740 Office Support (154)
# ] ADCON DEMO-ABSD (127)
= '_‘6'5{1‘..! 15 (11)

Sae iy

Mhon. dnz.adcon ot . Akt it ) "y

OK | Cancel |

Figure 7. Tag Chooser Dialog

Click a device in the left panel to see its available tags in the right
panel.

Note: Only digital tags are available as valves.

3.

4,

If the available tag is one you want to add, select it and click OK.

You will easily be able to distinguish the tags you want if you
named them appropriately, as mentioned above.

You can select multiple tags with Ctrl-Click or Shift-Click.
Repeat steps 2 and 3 for each tag you need.

Note: The tags in the extension instances are not the same, even if they

use the same node ID. For example, if you have two addTIMER
extensions in two areas that use the same RTU and/or same
digital tag as a valve, they won't show the same status if one
switches and the other one doesn't.

If you need to remove a tag from the Valves list, select it and click the
Delete button.



CHAPTER 2
Adding Programs

After you have added the various outputs as input tags for the
addTIMER Extension, you can create an Irrigation Program.

Follow these steps to add a program to the extension:

1.

If the addTIMER Extension is not currently open, right-click it in the
Explorer, then select Properties.

On the Extensions tab, click the Add button. The New Program
Setting dialog shown in Figure 8 is displayed.

3 http:/lion. dmz.adcon.at: BOBO - Edit Program settings - Mozilla Firefox

Name:
Enabled: ®enabled O disabled

Shifts 1 Run Types

Duration Used valves in this shift: Available valves:
Digital output (inverted, OV = on) Digital output (direct, OV = off)
Digital output (inverted, OV = on)

- I

OK Cancal

Figure 8. Shifts Tab in New Program Settings Dialog

This dialog has two tabs, Shifts and Run Types. Use the Shifts tab
to establish the number and duration of the shifts and which valves
to control. Use the Run Types tab to determine how often the
program will run.

Click the Add button on the left side of the dialog to add a shift to
the list box on the left, then select the duration of the shift in hours
and minutes. The maximum is 18 hours.

The default setting is for the shift to be Enabled, but you can
deselect the checkbox to disable the shift.

The list box on the right side shows the valves available in the
extension. Select a valve and click [€] to move the valve to the
middle list box, which shows the valves used in the current shift.
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You can use Ctrl-Click to select more than one valve or click to
move all of the valves to the middle list box.

5. If you have a Main valve, you must add it to each shift.

6. Repeat steps 3 and 4 until you have added all of the shifts you
need.

7. Verify that the Enabled radio button for the program is selected.

Controlling When a Program will Run

Using the Run Types tab, follow these steps to set up when and how
often the program runs:

1. In the New Program Settings dialog, select the Run Types tab to
display the dialog shown in Figure 9.

3 hitp:Hlion.dmz.adcon.a1:BOBO - Edit Program settings - Mozilla Fir... E|@!®
Name: Direct Digital Output

Enabled: ®enabled O disabled
Shifts | Run Types |

—Repeat interval

O No repeated execution
@ Continuous

O Daily

@ Days of week: MI_'-rJTI_lt-|'.’-'»2|;'|TI ._| rril'E-a-'jS-.u'J

O Every: i—: *1Days

~Repeat interval parameters:

Begin Date: |February b, 2008 [~ Begin Time: 08:00 2]
Duration Factor: S

Cycles per Day: I—" =

Delay between cycles: (0030 | 3]

—Additionally once at
3/10/08 5:08 PM with factor 1.1

(L=
OK | Cancel I

Done

Figure 9. Run Types Tab in New Program Settings Dialog
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2. You'll use the first pane on this dialog, Repeat Interval, to
determine how often the program should run. Select one of the
following choices

No repeated  No default program is running. Only the programs entered
execution:  in “Additionally once at” are executed.
Continuous:  The program runs continuously.
Daily:  The program runs once each day. The total run time must
be less than 24 hours.

Days of Week:  The days of the week display as push buttons. By default
no days are selected. The program runs each day you
select. The total run time must be less than 24 hours.

Every x Days:  The program runs after the number of days have elapsed.
1 = every day (same as selecting Daily, above), 2 = every
second day, and so forth. The total run time must be less
than 24 hours.

The total run time is calculated as follows:
(S * df * cycles) + ((cycles - 1) * delay)

S = sum of all shift durations

df = duration factor

cycles = number of cycles per day

delay = delay between cycles

In other words, a run time consisting of two cycles with three shifts each and a
delay between cycles could be represented like this:

“ Shift 3 I Delay Shift 3
J

L

k2 %
Cycle 1 Cycle 2

Total Runtime

3. The middle pane on the Run Types tab establishes the parameters
for the repeat interval you selected in the first pane. The Repeat
Interval you chose above determines whether the Cycles per Day
and Delay Between Cycles fields are available.

a. Enter a Begin Date and Begin Time for the program.
b. Enter a Duration Factor.

Use the duration factor to increase or decrease the irrigation
run times. The default value is 1.00 but you can lengthen or
shorten the irrigation run times for all shifts in the program by
changing the factor. For example, if a shift has a run time of 10
hours and you set a duration factor of 1.2, the shift will run for
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12 hours. The factor does not influence the delay between
cycles.

c. Enter the number of Cycles per day.

This field determines how many times each day the program
will run.

d. Select the Delay between cycles.

If you set the Cycles per day to a number greater than 1 or if
the repeat interval is Continuous, you can enter a delay (in
hours and minutes) between the completion of one cycle and
the start of the next. The default value is 00:00 and the
maximum value is 23:59.

4.  The last pane on the Run Types tab, Additionally Once at, enables
you to define run times that overrule the scheduled times. Click the
Add button to display the dialog shown in Figure 10.

© http:{flion.dmz.adcon.at:B0B0 - Add a new Once Schedule i... g [l g|

Begin Date: January 28, 2008 B
Begin Time: 17:09 |29
Duration Factor: 110 : A

Cycles per Day: 1 £2]

Delay between cycles: 00:00 ::{

oKk | Cancel |

Done

Figure 10. Add a New Once Schedule Item Dialog

The fields are the same as the ones in the Repeat interval
parameters pane. An example of when you might use this feature
would be that you created a daily runtime but on a certain day
you'd like to irrigate either more or less. You would enter a date/
time along with a factor, cycles per day, and delay between cycles.

Note: Runtimes set on a “Once Schedule” such as this have a higher
priority than scheduled runtimes, which means that a Once could
block a starting Schedule and it could interrupt an already
running scheduled task.

You can remove a Once by selecting it in the list and clicking the
Delete button.
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Select Edit on the Extensions tab to display the Edit Program Settings
dialog. You can change the fields and properties on this dialog the
same way you did when you created the new program.

If you change the settings of a program while it is running, the program
is stopped and restarted with the time that has already elapsed.

As an example, we'll use a program started at 16:00 with a duration of 3
hours, meaning it would normally run until 19:00. However, at 17:00,
you change the start time to 15:00.

Program is scheduled to run from 16:00 to 19:00

16:

00 17:00 18:00 19:00

You changed the start

A

time to 15:00

Today, program runs from 16:00 to 19:00
because start time had already passed.
Tomorrow, it will run from 15:00 to 18:00.

You might think that the program would run until 18:00, which it would
with a duration of 3 hours. But since you changed to a start time that
had already passed, the program will run until 19:00 as usual because
otherwise the program would be an hour short. Tomorrow, the program
will run from 15:00 to 18:00, but today the program will continue its
original run from 16:00 to 19:00

What if a program is supposed to start at 16:00 for 3 hours (as above),
but at 15:30 you set the program to start at 15:00? Since the program
should have already run for 30 minutes, the time trigger that tells the
program to start was missed (it was fired at 15:00, but now it already is
15:30). Therefore, the program will not start today at all, but will start
tomorrow.
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Program is scheduled to run from 16:00 to 19:00

16:00 17:00 18:00 19:00

You changed the start .
time to 15:00 Today, the program will not run
because the start time had passed.

- Tomorrow, it will run from 15:00 to 18:00.

After tomorrow, you stop the
program before 15:00. At
15:30, you set the program to
start at 16:00.

The day after tomorrow, the program
runs from 16:00 to 19:00.

If, on the other hand, you stopped a program that should have started
at 15:00, and then at 15:30 you set the start time to 16:00, the program
will start at 16:00.

The addTIMER extension allows you to create multiple irrigation
programs. One or more of these programs can then be set to operate at
any time. In smaller systems, however, you will typically have only one
active program.

If you do want to have two or more programs running at the same time,
make sure that you have given due consideration to the impact on water
flow and pressure. Ideally, each program should be limited to stations or
valves on a specific mainline. If two programs run together on a
mainline, you could find that the flow through the valves is more than
the pump can deliver, which will cause system pressure and therefore
uniformity to fall.

To activate or deactivate a program:

1. Open the addTIMER Extension properties.
2. Click the Extensions tab to show a list of the available programs.

3. Click the Enabled checkbox to activate the program, or clear the
checkbox to deactivate it.
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You can delete a program by selecting it from the list on the Extensions
tab and clicking the Remove button. This stops the program and closes
all of its valves.

When you click Refresh on the Extensions tab, the Programs table is
displayed again, but internally it is freshly rendered. For example, you
might click Start on one of the programs, but the command for the
valve to be opened takes some time to reach the RTU. If you need an
immediate response, you can click Refresh to get all the actual statuses
of the program.

You can check the status of a program at any time from the Extension
tab of the addTIMER Properties window.

To check a program'’s status:

1. Open the addTIMER extension’s Properties window.
2. Click the Extensions tab to show a list of the available programs:
. NEEEN. - program is active and a shift is running.

. Yellow [: the program is active but no valves are running.
The program typically shows that it's waiting for the next
execution time.

o [FGray Tl the program is disabled (no warning/alarm on

valves).

Once a program is active, you can manually override the programmed
settings using the Start and Stop buttons in the Extension Properties

window. For example you can stop an operating program or start one
that is waiting.

* Ifyou click Start while a program is running, the operating
program is cancelled and a new instance is started.

e Ifyou click Stop when a program is running, the program will
stop immediately.
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* Ifyou click Stop when a program is not running, no action is
taken, but a message is written to the logs.

You can open a closed valve, or close an open valve by using valve
control from the Inputs tab on the addTIMER Extension.

With the extension’s Properties window open, click the Inputs tab. A list
of the valves added to the extension displays, along with the status of
each.

e  Click the Open button to open a valve.

A dialog displays, asking you to select the time you want the valve
to be opened. If no programs are running, you might first have to
open the Main Valve.

e Click the Close button to close a valve.
If the valve is open, it will be closed immediately.

If you send an Open command to a valve that is already open, the old
settings for the valve (the time left to run) are dropped and the new run
time is written to the valve. This allows you to override the automatic
settings and force a valve to open if something went wrong or you want
to irrigate for a longer or shorter time.

The addVANTAGE Pro 5 server generates error messages when
necessary, perhaps because of radio communications problems or a
valve that cannot be opened.

When an error condition has occurred, a red alarm dot displays next to
the addTIMER extension (and all of its parent nodes).

To view the list of alarms:

1. Right-click the addTIMER extension and select Show Alarms.

2. When the events list displays, use the navigation buttons to select
a time span that allows you to see the alarms.

Alarms that have not had any action taken against them display in

red.
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Review the list of alarms to identify the cause. For example, does
an RTU have a flat battery, has a relay device failed, or has the RTU
lost communication?

After reviewing the alarm, click the box next to the alarm to
acknowledge it. If there are multiple alarms, click the
Acknowledge button and select Acknowledge All Alarms.
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